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Part 1: Recording Sounds in the Field
Studies of acoustic communication rely on accurate recording of sounds in the real world and detailed digital analysis of the signals. In this activity, you will learn to record sounds in nature with the kind of equipment typically used by researchers. You will then use your understanding of the basic properties of sound gleaned from the sound tutorial and the tools in the program Raven to analyze your recordings. 
 
The Activity
Divide into groups of 2-3. Using the equipment provided, take turns recording.

There are two recording exercises to accomplish, not necessarily in this order (there is only one sound chamber so it is best to stagger its use):

· In a controlled sound field (anechoic chamber in lab), each group will playback and record a clean version of animal vocalizations at 1 m distance. 

· Now in a real ambient soundscape (somewhere outside), at two different distances (e.g. 1 m vs 6 m away), record this same vocalization at each distance. Use the SPL meter to record sound pressure levels during the acoustic recording. Remember to calibrate your recorder to be near (but not exceeding) saturation at 1 m. 

· If you are lucky and happen to have live vocalizing animals nearby (e.g. tufted titmice), try recording their signals as well (but be mindful of your time).

You will be recording sounds using either a directional (shotgun) mic or a parabolic mic setup. If you have time, try both setups. Catalog your recordings in your notebook (don’t forget to note which mic setup you were using). Make your first recording without using the headphones. Then, listen to what you recorded. For all recordings after your first one, be sure to monitor in the headphones as you are making them. The Marantz digital recorder only records what you hear in the headphones. In the second part of this lab, you will use your recordings for the analysis so you must save these sounds (e.g. on a flash drive or email) when you are finished. 

List of Field Equipment 
Digital recorder (1) (this should be set to “Preset #1” under Menu>Presets)
Shotgun (directional) or parabolic (omnidirectional) microphone (1) 
Windscreen (1) 
SPL meter (1)
Headphones (1) 
Memory Card (1)
AA Batteries (5)
Notebook and Pencil 

Cataloging Your Recordings in the Field 
Before making a recording of a sound, speak into your microphone in order to record, on the same track with each sound, relevant information regarding your recording. Remember that you will make many recordings and you will not be able to remember which was what without these field notes. Begin each recording bout by saying who, where, when and what you are attempting to record. When you are working with ectothermic animals, like frogs and insects, it is necessary to record the temperature of the environment. In those cases, note the temperature as close to where the animal is signaling as possible. You should also make a note saying something about the general weather conditions: e.g. cloud cover, wind, vegetation. After each recording bout, verbally record what kind of sound it was, precisely where it was recorded, and the approximate distance from the microphone the animal was positioned. It is important to also keep a catalog in your notebook with information on the type of sound, its position on the card, and where each sound was recorded and the temperature at the time of recording. Also, note things like the behavior of the animal as it was making the sound, its location, and other animals it might be responding to. You can try to do this as you are making the recordings, or it may be easier to do so at the end of each day. Here is an example of a logbook:

	Marantz track #
	Sound
	Date/time 
	Location/Observations
	SPL (dB)

	000-020
	Gray squirrel calls
	1/30/16; 14:00
	North end of Crum
8°C, parabolic mic
	59 dB

	005
	Owl call @ 1m 
	1/30/16; 14:20
	- playback 1m distance;
	76 dB

	006
	Owl call @ 6m
	1/30/16; 14:30
	-playback at 6m
	70 dB



To record the position of the signal on the track, scroll through the track and note the time (format: 00:00) when the sound begins. 

Using Recording Equipment 
Recording sound is a relatively straightforward procedure, not much different from recording a lecture or interviewing your grandmother. However, animal signals present some special problems that these other things do not. In general, there are three major issues to be aware of: clipping, noise, and signal calibration. Other problems include selecting equipment that is capable of detecting the sound you are interested in. Since we will all be using the same equipment here, this will not present so great a problem. 
Clipping 
Sounds vary a great deal in amplitude. If the amplitude of the sound exceeds the maximum threshold on the recorder, the signal will be clipped. This will cause you to lose parts of the signal. The figure below shows a normal signal (left) and a clipped (right) for comparison. The recording level can be adjusted on the tape recorders we use in this lab. Choose a recording level for each sound while monitoring the LED gauge on the surface of the recorder. It is best to set the level so that the signal of interest is as close to the maximum without exceeding it. Aim for three to four green and orange lights blinking with the sound but NO RED. Red means you are clipping (right).

[image: ]Noise 
When making a recording, there often will be other sounds in the background at the same time. Factors such as wind, automobile traffic, and other animal sounds contribute to noise and make it difficult to get clear recordings. Go back periodically and listen to your recordings. Try to stand in places where the wind is blocked or wait until the wind dies down. It is impossible to eliminate all noise from your recordings. If you use common sense, you can exclude most of it. 

Signal Calibration 
Sound decreases in amplitude with distance. Thus, under most conditions, the amplitude of the signal on your tape does not correspond to the amplitude of the sound where it was emitted (at the animal). There are ways to calculate the absolute amplitude, but in all cases you need to have done two things while recording the sound in the field: 1) Make careful note of the distance from the animal to the microphone. 2) Record all the sounds you wish to compare at precisely the same recording level. For today's lab, we will not be concerned with signal calibration. However, in your independent projects it might be key, and it is something to keep in mind at all times when you are recording and analyzing animal sounds. 

SPL meter
Use the Sound Pressure Level meter to record the SPL (dB) of your sounds. 
SPL meter settings: select dBC (unweighted); choose between Slow detector (integrates over a 1 sec time window) and a Fast detector (integrates over 125 ms time window) depending on whether your sound is long or short; select either Hi or Lo depending on the basic range of pressures you are measuring; mic angle with respect to sound source = 0 degrees. 

The 'Sound Tutorial' 
It is important to keep the basic properties of sound in mind when making recordings. The 'Sound Tutorial' posted on Moodle and available on the PCs in the the lab describes these basic characteristics as well as some of the techniques for digital analysis. It will be available throughout this course for you to use as a reference and although it is not a graded assignment on its own, you will be expected to know this information. 


Part 2: Descriptive Analysis of Sound 
This portion of the lab will take you through the process of describing and comparing sounds and train you to use some of the common tools and language employed by biologists today. You might use these tools for your independent project. If you do not complete this part during this week’s lab hours, you should plan to work on it on the iMacs in the Computer Lab in Martin or in M204. 
We will be using Raven and Audacity software to analyze sound.  You can download Audacity for free and install them into your computer going to the following link: http://audacity.sourceforge.net/ 
Goals 

(1) Practice using Raven
(2) Learn the basic tools of signal analysis: waveforms, spectrograms, power spectra. Understand the Frequency Domain and the Time Domain of sound. 
(3) Measure parameters of signals (e.g. maximum freq, duration, rise time, etc)
(4) Verbally describe sound signals following guidelines online: http://earbirding.com/blog/specs

(5) Compare two spectrograms using cross-correlation analysis (CCA). Understand what this CCA coefficient means and how a CCA using spectrograms differs from a CCA using oscillograms. 
Definitions

(1) Clipping 
The problem of clipping was discussed with regard to field recording. 
(2) waveform: a graph of amplitude over time (aka oscillograms)
A waveform is analogous to an oscillogram obtained from an oscilloscope. It is the simplest, most direct translation of a sound into a picture. Each of the other two graphs is calculated from the waveform, not acquired independently from a recording.
Information which can be obtained from waveforms: 
· Duration of a signal 
· Rate --i.e. calls per unit time 
· Changes in amplitude over time (rise time, fall time) 

(3) spectrogram: a graph of frequency by time (aka sonograms)
Information which can be obtained from spectrograms: 
· Temporal changes in frequency (e.g. up-sweeping) 
· Subtle differences in signals not apparent from other graphs 


(4) power spectrum: a graph of amplitude by frequency (aka frequency spectra)
It describes how much energy is contained in each frequency of a signal, averaged over a specified time interval. 
Information which can be obtained from power spectra: 
· Frequency composition of a signal 
· Dominant frequency of noisy signals 
· Carrier frequencies, harmonics, and beat frequencies 

(5) Sampling Rates and Aliasing: 
The interval between the sampling points the computer selects from a continuous sound is called the sampling rate. If the sampling rate is too low (i.e. the interval between points too long), the sound will be grossly misrepresented by the computer. This is called aliasing. In general, the sampling rate needs to be twice as high as the maximum frequency of the sound you are recording (called the Nyquist frequency) in order to prevent aliasing. The hardware we are using in this class can sample at up to 44 kHz sampling rates. This is such a high sampling rate that for the most part you do not have to worry about aliasing. Nevertheless, it is important to be aware of this potential problem. There is a more complete discussion of aliasing on in the companion website to Bradbury and Vehrencamp (2nd Ed) at:
http://sites.sinauer.com/animalcommunication2e/chapter02.04.html
http://sites.sinauer.com/animalcommunication2e/chapter02.04.01.html



Seeing Sound: Guide to Raven[image: bowheadwaveform]
Fig 1. . Waveform output from Raven Pro. The sound shown happens to be that of a portion of a bowhead whale song. The vertical axis shows loudness and the horizontal axis is time. Units shown on the time axis depend on the size of the display window used, in relation to the sound’s rate; here, the units are seconds. 

Waveforms, spectrograms and power spectra 
Raven Pro
The software program we will use for investigating animal sounds is Raven Pro. This program was produced by the Cornell Laboratory of Ornithology for its Bioacoustics Research Program (http://www.birds.cornell.edu/brp/index.html).
Raven Pro lets you open digital sound files and then display them in several ways. One default way of looking at a sound is as a waveform (aka oscillogram), which is a graph of loudness (in kU or “kilounits”; also called the amplitude or intensity of the sound) on the y axis vs. time on the x axis (Fig. 1). 
Often it is more informative to view sound files for study in animal behavior as spectrograms (aka sonogram). This type of graph represents a sound by its pitch, or frequency (in units like kilohertz, kHz, or just hertz, Hz) over time (Fig. 2).[image: larksparrow]
Fig. 2. Sonogram output from Raven Pro. The vertical axis shows frequency and the horizontal axis is time and the darkness of the signal represents amplitude (intensity). The sound shown is part of a lark sparrow song.




[image: ]
Fig. 3. A power spectrum (aka frequency spectrum). is a third way to visualize sound. Frequency is on the x-axis and amplitude (dB) is on the y-axis. This tells you what frequencies most of the call energy is concentrated in. 

Sound file formats
Sound files can be in a variety of file formats. The best format to use for analysis in Raven Pro can recognize are:
Wave	(filename with extension *.wav)
Aiff	(filename with extension *.aif)
For Wave and Aiff formats, bit depth can vary. A file saved at 8 bits will be smaller but less detailed in terms of the information stored; a 24 bit sound file will have lots of detail, but will be a larger file.

Using Raven Pro, perform the following 4 items:
1. View your recordings as waveforms, spectrograms and power spectra (refer to B&V ch. 2 or the Sound Tutorial for full descriptions of these three visualizations). You might need to adjust the brightness and contrast of the spectrogram view—Raven Pro’s default is set to über-sensitive. To do this: 
> open a file
> go to the toolbar and click “View”
> Configure Brightness and Contrast…
> adjust the Brightness level until an optimal visualization is reached. Be careful to not lose signal information by making contrast or brightness too high. 
View your recordings (or sample files on Raven Pro) using the three visualizations listed above. 
After viewing a few of your recordings select some of the cleanest ones: one of your H. versicolor and H. chrysoscelis recordings from the chamber and outside. Use the scissors (cut) tool to trim the recording so that there isn’t much pre- and post-stimulus silence. Then re-save and re-name these files using a file name that is sensible (e.g. versicolor_outside_1m.wav).
Filtering Digitized Signals 
Natural sounds occur in a background of other sounds. These other sounds are distracting and can bias certain kinds of analyses like cross correlation. Most researchers will perform band-pass filtering on signals once they are digitized in order to make analysis easier. This eliminates most of the extraneous background noise around the signal of interest. 
Raven Pro will allow you to do bandpass filtering. The terms “high-pass” and “low-pass” are often confusing at first. The high-pass filter allows frequencies higher than your selection to pass and cuts out the lower frequencies, and vice versa for low-pass filters. These two limits set the passband. 
Filters are great tools that may provide cleaner recordings, but you should carefully determine the frequencies of your sound before filtering it. Filters are not perfectly sharp excisions. So, be careful not to choose frequencies too close to the signal. 

To filter a sound in Raven Pro do the following: 
> Edit
> Band Filter
> All with
> New Filter
> Band Pass
> set passband appropriately for your signal and noise spectra

2. Verbally describe your sounds. 
(a) In a few sentences, verbally describe (using adjectives and comparisons, etc) the H. versicolor and H. chyrsoscelis. 

Refer to this online guide: http://earbirding.com/blog/specs

3. Measure parameters of your sounds.
Using the tools in Raven (cursor, different sound visualizations) determine some of the major characteristics such as duration, rate, max Hz, min Hz, dominant Hz, etc, as appropriate for your sounds. 

4. Performing cross-correlation analysis:
a. Compare your H. versicolor field recordings to your chamber recording. How would you describe the difference between the real world and a controlled sound field?
b. Cross correlate your H. versicolor field recordings at distance 1 (e.g. 2 m) with distance 2 (e.g. 4 m)
Use Raven to perform the cross-correlation analysis:
>Tools
>Correlator
	> Choose files: load your near signal as File1 and the far signal recording as File2
	> Correlate: select “Spectrogram” radio button
	> Options: select “Normalize” and “linear power”
	> Click “Okay”, close “Progress Manager”

The correlation graph will be depicted at the top of the window. The peak correlation value will be highlighted with an intercept on the y-axis in units u (0-1.0) or mu (range 0-1000). Record this peak CCA coefficient as a decimal value between 0-1 (see table below). This correlation coefficient tells you about how the sound degraded over that distance. 
Degradation: changes in spectral and temporal characteristics of a signal due to distance or environmental effects
But sounds can also simply lose intensity over distances.
Attenuation: reduction in signal power with distance from the source
Excess attenuation: reduction in signal power greater than that due to spherical spreading of sound
Selective attenuation: reduction in the signal power of some frequencies but not others

SPL changes as a function of distance. Theoretically spherical spreading will result in SPL changing as follows:  
SPL = 20log(p2/p1)           (equation 1)
In our case, p1 and p2 represent the pressure of signal 1 and signal 2, respectively. When signal 1 and signal 2 differ only by virtue of the fact that they were recorded at 2x the distance between the source (speaker) and the mic (i.e you didn’t change the recording sensitivity or speaker loudness and nothing in the environment interferred), then the ratio of p2/p1 becomes 0.5. 
Thus,
Change in SPL = 20log(.5)
The SI unit for pressure is N/m2 or Pa, and in these units pressure changes linearly with distance (thus the halving of the ratio above). But our autidory systems and the auditory system of most other organisms do not perceive sound pressure in a linear fashion. Thus the unit dB which is logarithmic was introduced because perception of sound pressure follows a logarithmic function. Therefore equation above will reduce down to approximately -6 dB per doubling of distance – which is a handy rule of thumb to remember. Do the calculation of the equation above to find the exact value for change in SPL per doubling of distance. Then, look at the change in dB values you saw when you doubled the distance between the speaker and mic for one of the Hylid calls: was there approximately a 6 dB change in amplitude measured with the SPL meter?
Different environmental conditions lead to different patterns of degradation and attenuation. For example, sounds transmitted through a complex environment like a dense forest encounter reverberations that degrade the signal. Lower frequencies transmit better than higher frequencies in a dense forest. So, a forest can act as a filter, selectively attenuating higher frequencies. Another example is reflectance: reflected sounds can interfere either constructively or destructively with the original sound, contributing to excess attenuation (or in some cases negative excess attenuation). Thus, sounds produced near a surface will be degraded differently than sounds produced far above a surface. A rocky surface will reflect more sound than the detritus-covered surface of a forest floor, and water reflects even better than rock. There are many more physical properties of the environment that can affect the transmission of sound (see Wiley and Richards 1978 for a good description).  

Additional Detail on Cross Correlation Analyses 
When analyzing calls from different animals, it is often useful to evaluate the overall similarity of two signals. Cross-correlation analysis is a method for determining the similarity of two signals based on the overall shape and structure. Cross-correlation can compare waveforms, power spectrums or spectrograms. Mathematically, this involves treating the graph as if it were a matrix. For example, picture the cross correlation of two spectrograms. First, each spectrogram is divided into a matrix of frequency by time. Then, the similarity of the two matrices is calculated as one signal is incrementally slid past the other. The outcome will be a graph of similarity (as a correlation value) by time. Time in this case is the amount of offset between the two signals. At time = 0, the two signals are aligned at their starting points. This process is explained in greater detail below. 
An Example of Cross Correlation... 
The following is a simplified example of cross correlation of two frequency sweeps: one concave up; the other concave down. This simplified version illustrates the process that Raven uses to do cross correlation with more complex signals. Below are spectrograms of the two signals. Spectrograms are stored as matrices. Each matrix below represents the spectrogram above it. The numbers in each cell of the matrix are hypothetical values for the amplitude of the signal at each point in frequency and time. Obviously, the signals could be divided into finer resolution matrices. However, a 3x3 matrix makes calculations much simpler. 

[image: ]



  Next, these matrices are aligned with one another: 
[image: ] 
       
                                                                              
To compute the overall similarity of these two signals, Raven calculates the correlation coefficient of these paired sets of numbers. The graph below shows Signal 1 plotted against Signal 2 and the correlation coefficient (r). Since r = .541, the overall similarity of Signal 1 and Signal 2 is calculated to be about 54%.
[image: ]
This calculation was done with no offset between the two signals. Where one signal begins, so does the other signal. Usually, this is all you want to know. In some cases, however, it is more important to know what degree of offset yields the highest correlation value. For example, this is useful when the same signal is recorded from two locations. In that case, the degree of offset between the two recordings would represent the time delay of the signal arriving at the two locations. From this time delay the distance of the signaler can be calculated. This process is shown below: 
[image: ]

This above figure shows how the program slides signals past each other, incrementally calculating correlation values. The relative position of the asterisk indicates the degree of offset. For each graph, the program calculates the correlation coefficient for the values in the gray area. A table of the correlation values is shown below (t = degree of offset, r = correlation coefficient).
[image: ]
Raven will do this procedure and will report the peak correlation value (below diagonal) and the delay time (above diagonal) as the output (see below):
If the coefficients are closer to 1 (or negative 1) that means that the signals are similar and if the coefficients are close to zero the signals are very different. The sign (+ or -) tells you the direction of the relationship. If it is positive, that means that as one signal’s parameter goes up, that parameter for the other signal goes up, and vice versa. A negative relationship is particularly useful if you are performing your CCA on the oscillograms (instead of spectrograms) because it tells you the degree to which your two signals are out of phase with each other. If they are 180 degrees out of phase, but otherwise identical, you will get a CCA of -1.0 for the oscillograms. Can you think of circumstances in which this could be useful (hint: the Navy uses this for sonar)?
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